
In this session, I’ll share how Bluebeam Revu and custom 
markups are leveraged to plan, order and track construction 
activities in a complex, multistory concrete project. Working on a 
multi-level structure, we will define concrete pour areas, 
reinforcing areas and areas with different thickness and details. 
With custom fields and formulas, we tracked quantities, progress, 
live percentage-complete tracking, and instant coordination 
between office and field teams – all within Bluebeam Revu
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Concrete Construction with 
Bluebeam Custom Markups
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“ Good construction begins on 
site; great construction begins 
on paper  Bluebeam.

R.J. Industries, Estimator/Project Manager

Kenneth Padover



Agenda
Opening – Introduction to the Revu Interface - Left Panel Overview (Icons)

Section 1 – Page Labels and Sets

Section 2 – Tool Chest

Section 3 – Profiles & Setup

Section 4 – Dynamic Fill (Slab & Openings)

Section 5 – Markup & Area Counts

Section 6 – Markups Lists – Columns, Custom Columns, and Formulas 

Fundamentals

Section 7 – Formula Library – A Deep Dive into Various Concrete Formulas

Section 8 – Markup List Totals & Exports



Agenda
Section 9 – Live Schedules (Legends)

Section 10 – Set-Wide Reporting

Section 11 – AI/Scripting Teaser (Optional)



© 2025 Bluebeam

Opening – Introduction to the Revu User Interface

Left Side Overview (Icons)

• File Access – recent files, pinned folders.

• Thumbnails – page navigation, revisions, labels.

• Bookmarks – jump to anchors.

• Layers – toggle disciplines/markups.

• Tool Chest – reusable tools.

• Links – manage hyperlinks.

• Spaces – define areas for rollups.

• Properties – edit selected markup.

• Measurements – calibrate drawings, adjust precision.

• Forms / Signatures / Flags / Search / Studio – additional project tools.
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Quick Keys:

• Text (T),

• Typewriter (W)

• Note (N)

• Callout (Q)

• Line (L)

• Rectangle (R)

• Ellipse (E)

• Polygon (Shift+P)

• Pen (P)

• Highlight (H)

• Eraser (Shift+E)

• Cloud (C)

• Cloud+ (K)

Menu Toggles:

• F9 → hide/show top menu

• Alt+T → open Thumbnails.

• Alt+L → open Markups List.
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Section 1 – Page Labels & Sets

Organize drawings into smart, linked collections



• A Set is a collection of many individual PDFs – it does not merge files

• Files remain as individual pdf drawing files

• Files can be organized by discipline based on already setup prefixes or custom prefixes

• Revised drawings can be recognized and organized when updating the set with revised 
plans

• Slip-sheets keep history; latest revision is shown by default.

• Older drawings could be marked as superseded, but still accessible

• Search, hyperlinks and page labels work across the set.

What is a Set



• A page label is like a custom name or identifier you can assign to each page, In 
addition to it number

• Labels can match drawing numbers. Sheet numbers, or any other convention your 
project team users.

• They can be a combination of drawing number and drawing title

• Labels drive navigation, Sets, exports, and Legends

• Losing labels creates chaos later

• Keep consistent page labels from the start

What are Page Labels



• Consistent Page Labels (match drawing number; option to add title after a 
dash)

• Losing labels creates chaos later

• Keep consistent page labels from the start

• Expedites creating individual drawings from drawing files with multiple 
drawings

Prerequisites for clean sets



Creating page labels
•Open the Thumbnails panel (left toolbar or Alt+T).

•Select the pages you want to label (Ctrl+A to select all, or Shift+click for a range).

•Right-click on the selected pages → Page Labels….

•In the Page Labels dialog, choose how to create labels:

•Manual entry — type a custom prefix, suffix, or numbering.

•Auto-generate from Page Region — drag a box around a title block area (like Drawing Number or Sheet Title).

•Auto-generate from Bookmarks — if bookmarks are set up, labels can inherit them.

•Typically, I like to use the drawing number for the page label, option to add the drawing name

•Preview the results in the dialog before applying.

•Click OK → the labels will appear in the Thumbnails panel, Page Navigation bar, and anywhere page labels are 

used.

•Review page labels to address if the labels were correctly applied

•Edit or reselect range if errors have occurred

•Manual edit of the page label in the Thumbnails panels if needed



Extracting drawing pages from the Thumbnail Tab

Open the Thumbnails panel (ALT_T or left-side toolbar) to see all the pages in the PDF

Select the pages you want to extract.

• Single click for one page

• Ctrl+Click or Shift +Click for multiple pages

Right-click on the selection and select Extract Pages…

• Choose to extract as individual PDFs or combine into a single new PDF

• Decide whether to keep the page labels as filenames



Create / Modify as Set (steps)

• File → New Set → Add folder/files; auto-detect names from Page Labels.

• Save the .bex next to your PDFs; open Modify Set for categories/stacking options

• Slip-sheet: right-click sheet → Add Revision…

• Or select Modify set button and select add to add new drawing files

• Automatic revision updating if file names are the same



Pitfalls & Common Issues
• Unreadable drawing numbers or filenames – some block letters or 

drawings do not get properly recognized during the pagel label generation 
process and need to be updated manual

• Inconsistent drawing number locations – Architectural drawings and 
Civil drawings as well as others can be done differently. Use Automarek on 
the range of files not properly labeled or enter individually.

• Protected files – some firms lock or protect drawing – sometime printing 
or saving to a new pdf could help

• Revision numbering quirks – some projects issue drawings with .00 
extensions with .01, .02 for revisions
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Section 2 – Tool Chest

Standardize and reuse markups for speed and consistency



Tool Chest – Purpose & Payoff

Reusable library of markups, standardizes subjects, layers, appearance

• You can save markups (symbols, callouts, dimensions, etc.) once and 
reuse them in a drawing

• Keeps you work consistent and saves time with uniform appearance

• Also enables you to create counts based on areas

• Faster placement with Reuse



Key Features
1. Reusability

• You can save markups (symbols, callouts, dimensions, etc.) once and 
reuse them in any drawing.

• Keeps your work consistent and saves time.

2. Custom Tool Sets

• Organize tools into categories (e.g., “Concrete Markups,” “MEP 
Symbols,” “QA/QC”).

• Tool sets can be exported and shared with your team for 
standardization.



3. Dynamic vs. Properties Mode

• Properties Mode: Markups reuse the exact same properties every time (same text, 
size, color).

• Drawing Mode: Markups are reusable but editable — like stamps you can resize or 
modify.

• Example: a dynamic rebar symbol scales with drawing scale, while a fixed "Approved" 
stamp always looks identical.

4. Auto-Scaling

• If you save a tool with a defined scale, Bluebeam can automatically resize it when 
placed on scaled drawings.

5. Sharing

• Tool sets can be exported/imported (.btx files), so everyone on the team uses the 
same standards.

• Great for company-wide consistency (symbols, highlights, takeoff markups).



Tool Chest – Custom tool set

• Ability to have all custom tools organized by name or discipline

• Ability to migrate across different computers or different projects



Tool Chest – Creating a custom tool set

Tool Chest panel → Manage Tool Sets… → Add → New → name and 
Display.

Export/Import for sharing.



Tool Chest – ways to add items:

Right-click a page markup → Add to Tool Chest.

Drag-select multiple → Add (saves a grouped tool).

Right-click a Legend → Add to Tool Chest (template).

Create custom Count: save shape/group → Tool Chest → right-click → 
Create Count.



Drawing Mode: tool remembers the last geometry; each 
click pastes that saved shape

Properties Mode: tool applies its properties to geometry 
you draw (recommended for measures)

Toggle via the tool thumbnail

Drawing Mode vs Properties 
Mode
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Section 3 – Profiles & Setup

Save and share your entire Bluebeam environment



Profiles & Setup – Why and When

Profiles save your entire Bluebeam environment – including Tool Chests, Custom 
Columns, Markups List configuration and interface layout.

By exporting/importing a profile, you can ensure consistent setups across your devices or 
share with your team.

Profile basis:

• A profile is stored as a .bpx file.

• Profiles capture Tool Sets, custom columns, toolbar layouts, keyboard shortcuts, and 
more

• Switching profile instantly changes the workspace to match saved preferences



Bluebeam Revu Profiles – What’s Included vs. Separate

Not Captured (Must Export/Import Separately)

 Tool Sets (Tool Chest) – export/import as .btx
 Stamps – saved in Stamps folder (.btx or PDF)
 Custom Line Styles / Hatch Patterns – export as .blx
 Custom Fill Patterns – export separately
 Custom Scripts / Batch Settings – managed locally
 Batch Plug-ins / External Integrations – remain local
 Digital IDs / Signatures – stored in certificate store
 Measurement Scale Calibrations – document-specific



Bluebeam Revu Profiles – What’s Included vs. Separate
Captured in a Profile (.bpx)

 Toolbar layout & menu setup
 Panel arrangement (Thumbnails, Tool Chest, Studio, etc.)
 Custom UI preferences (colors, snapping, units, etc.)
 Custom Columns in the Markups List (including formulas)
 Keyboard shortcuts (if modified)
 Status Model (review statuses, color codes)
 Recent Tools / My Tools layout
 Profile name & workspace theme
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Section 4 – Dynamic Fill (Slab & openings)

Turn irregular regions in accurate measurements fast



Dynamic Fill – why and when

• Fastest path from irregular regions to true measurements.

• Outputs: area, Volume, Perimeter, Polylength, Spaces



Dynamic Fill – work process
Calibrate once; select Tools → Measure → Dynamic Fill.

Add Boundaries across gaps: click on beginning of boundary , double-click 
at end 

Paint area by holding down left mouse button in area to be filled

Release mouse button when complete

Boundary areas can be added afterwards which will reduce the area

After boundary area is created, must be assigned to either a space, polygon 
markup, area or volume

Use cutouts to refine openings
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Section 5 – Markups & Area Counts

Apply standard subjects and layers for reliable takeoffs



Calibrate once → all measurements follow

Use Subjects & Layers to drive Legends/filters

Area for slabs/pads; Polylength for walls/footings/beam 
CL

Count for column pads, embeds, dowels

Markups & Area Counts –
Overview
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Markup Tools

Text & Notes Lines & Shapes
Highlights  & Drawing 
Tools

• Text Box

• Callout

• Cloud+ (callout with cloud and 
leader)

• Typewriter (text placed directly 
on page)

• Note (sticky note with pop-up)

• Line

• Polyline

• Arrow

• Arc

• Ellipse / Circle

• Rectangle / Square

• Polygon

• Cloud (polygon with clouded 
edges)

• Highlight

• Underline

• Squiggly underline

• Strikethrough

• Pencil (freehand line)

• Pen (smooth freehand ink)

• Highlighter (freehand highlight)
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Markup Tools

Stamps & Symbols Measurements Other Tools

• Text Box

• Callout

• Cloud+ (callout with cloud and 
leader)

• Typewriter (text placed directly 
on page)

• Note (sticky note with pop-up)

• Length

• Polylength

• Area

• Perimeter

• Volume

• Diameter / Radius

• Angle

• Count

• Dynamic Fill (region-based 
measurement and markup)

• Centerline (specialized length 
tool)

• Images (place an image as a 
markup)

• File Attachment (embed a file 
icon on the page)

• 3D Model Tree (for PDFs with 
3D data)

• Hyperlink (attach to markups or 
regions)



Measurement Tools
Linear Measurements

Length – Measures the straight-line distance between two points.

Polylength – Measures cumulative length across multiple connected segments (great 
for walls, piping, or ductwork).

Centerline Tool – Specialized for structural elements; automatically accounts for 
symmetrical width (e.g., wall centerlines).

Area & Perimeter

Area – Measures square footage by tracing a shape (rectangle, polygon, or freehand).

Perimeter – Measures the boundary length of a closed shape (total linear distance).

Volume – Calculates cubic measurements by multiplying area × depth or using 
formula columns.



Measurement Tools

Specialized Geometry

Diameter / Radius – Measures circles and arcs; outputs diameter, radius, and 
circumference.

Angle – Measures the angle between two intersecting lines.

Counting & Symbols

Count – Places a symbol to track discrete items (e.g., fixtures, anchors, doors).

Counts can be customized with icons, subject names, and reused via the Tool Chest.



Measurement Tools

Dynamic Fill

Converts irregular regions into measurement markups (Area, Perimeter, Volume, 
Polylength).

Fastest way to measure complex spaces like slabs with openings.

Supports cutouts for voids, and converts regions directly into Area or Volume tools.

Integration with Custom Columns

Each measurement tool can be linked to Custom Columns in the Markups List.

Example: CY formulas (cubic yards) are derived from Area or Length measurements 
combined with user-defined depth/width columns.

Outputs can be totaled, filtered, and exported to PDF or CSV summaries.



Concrete Coordination Sample

For our concrete example, we will be using the following measurement tools

• Slabs (Area)

• Footings-CL (Polylength)

• Beam-CL (Polylength)

• Column-Pad (Count)

• Column-Footing (Count)

• Walls (Polylength)

  



Building Markup based Counts

Typical Counts have preformed images that get placed and can be changed 
under the properties tab. These a checkmark, triangle, square, circle or 
diamond. Not much control is enabled on the display. However, you can 
create  count based on the following

1. Area-based count

2. Length-based count

  



Steps needed to create an area-based or 
length-based count

1. Create the area using a polygon area markup or a length by using a 
length area markup

2. Add this markup to the tool chest

3. Open the tool chest

4. Right click on the item in the tool chest

5. Select Creat Count

6. A new tool chest item is created and can be inserted using using the tool 
item
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Section 6 – Markups List – Columns, Custom 
Columns & Formulas

Transform your Markups List into a live project database



Your drawing’s live database of markups 
(measurements, counts, notes)

Every markup becomes a row; columns store attributes, 
quantities, and calculations

Results can be grouped, filtered, sorted, summarized, 
and exported (CSV/Excel)

Accessing it

Open any PDF→Markup List panel at the bottom
If hidden: View→Panels→Markups (or press Alt+L)

What is the Markup List



• Subject, Layer, Page, Author, Date/Time

• Measurement fields (Length, Are, Volume, Count) based 
on tool used

• Comments, Label, Status, Color/Line Style

• Custom Columns extend this with your own data & math

Built-in Columns (Quick Tour)



• Standardize takeoff inputs (e.g. , Faces, Bar Sizes, 
Spacing)

• Automate math (Formulas) so totals appear as you add 
measurement markups

• Create repeatable assemblies for walls, footings, 
dowels

• Attached data to markup items

• Export consistently to Excel

Why Custom Columns?



• Text

• Number

• Date

• Choice (dropdown) – predefined option list with option 
for numeric value to be used in formulas, can be just 
text, or text item that returns a number.

• Checkbox – Binary flags – returns a 0 or 1 which can be 
used within formulas

• Formula – math with built-in fields always put fields 
within brackets []

Custom Columns Types



• Avoid underscores; use spaces or dashes consistently

• Always wrap custom columns with spaces/dashes in 
[brackets] in formulas

• Use clear, specific names: Footing-Width-ft vs Width-in 
(generic)

• Keep a short glossary in your template to avoid 
confusion

Naming & Referencing Best Practices



• Markup List  → Manage Columns → Import/Export (XML)

• Share your setup company-wide; version your templates

• Export before major changes; keep a rollback copy

• Tool Sets (.btx) are separate (tools), not column definitions

Import / Export Custom Columns



• Operators: + - * /

• Parentheses: ( … ) for order of operations

• Numeric literals: 1.5, 12, 27, etc.

• Field references (in brackets):
• Built-in measurement fields like [Length], [Area], [Count]

• Your custom numeric/choice/check

• Checkbox columns evaluate to 0/1, so you can multiply by them as 
flags.

Formula – Fundamentals What’s actually 
supported
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Markup Tools

Added Reinforcing — Number

BeamDepth-in — Number

BeamWidth-in — Number

Bottom Reinforcing — Number

ColumnDepth-in — Number

ColumnWidth-in — Number

CY-Add — Number

CY-Beam — Formula

CY-ColFoot — Formula

CY-ColRect — Formula

CY-ColRnd — Formula

CY-Footing — Formula

CY-Slab — Formula

CY-Total — Formula

CY-Wall — Formula

Depth-in — Number

Dia-in — Number

Dowel-Bar-Size — Choice

Dowel-Len-ft — Number

Dowels-Along-Lbs — Formula

Dowels-Ends-Lbs — Formula

Dowels-Spacing-In — Number

Dowels-Total-Lbs — Formula

Ends-Bars-Per-End — Number

Ends-Count — Number

Faces — Choice

Footing-Height-ft — Number

Footing-Length-ft — Number

Footing-Long-Bars-Per-Sec — Number

Footing-Width-ft — Number

Height-ft — Number

Horiz-Bar-Size — Choice

Horiz-Spacing-in — Number

Horizontal Reinforcing — Number

L-ft — Number

Mix — Choice

Pour — Choice

PourDate — Date

Rebar — Choice

Rebar-Lbs--Vert — Formula

Rebar-Lbs-Horiz — Formula

Reinforcing Dowels — Number

Slab-MK — Choice

Thickness-in — Number

Top Reinforcing — Number

UnitCost-CY — Number

Vert-Bar-Size — Choice

Vert-Spacing-in — Number

Vertical Reinforcing — Number

W-ft — Number

Wall-Height-ft — Number

Width-in — Number



• No IF, ROUND, ROUNDUP, CEILING, MIN/MAX, SUM, AND/OR, string functions, or 
concatenation.

• No text math (a Choice that stores text like “#5” won’t multiply).

• No unit prefix or suffix parsing (you must convert inches feet yourself 
in the formula).

Formula – Fundamentals - What’s not supported



CY-Beam [Length] * [BeamWidth-in] / 12 * [BeamDepth-in] / 12 / 27 

CY-ColFoot [Count] * [Footing-Length-ft] * [Footing-Width-ft] * [Depth-in] / 12 / 27 

CY-ColRect [Count] * [ColumnWidth-in] / 12 * [ColumnDepth-in] / 12 * [Height-ft] / 27 

CY-ColRnd [Count] * 3.14159 / 4 * ([Dia-in] / 12) ^ 2 * [Height-ft] / 27 

CY-Footing [Length] * [Width-in] / 12 * [Depth-in] / 12 / 27 

CY-Slab [Area] * ([Slab-MK] + [Thickness-in]) / 12 / 27 

CY-Total [CY-Slab] + [CY-Wall] + [CY-Footing] + [CY-Beam] + [CY-ColRect] + [CY-ColRnd] + CY-Wall [Length] * 
[Height-ft] * [Thickness-in] / 12 / 27 

Dowels-Along-Lbs (([Length] * 12 / [Dowels-Spacing-In]) + 1) * [Dowel-Len-ft] * [Dowel-Bar-Size] 

Dowels-Ends-Lbs [Ends-Count] * [Ends-Bars-Per-End] * [Dowel-Len-ft] * [Dowel-Bar-Size] 

Dowels-Total-Lbs [Dowels-Along-Lbs] + [Dowels-Ends-Lbs] 

Rebar-Lbs--Vert ([Length] * 12 / [Vert-Spacing-in] + 1) * ([Wall-Height-ft] + 2) * [Faces] * [Vert-Bar-SizRebar-Lbs-Horiz 
([Wall-Height-ft] * 12 / [Horiz-Spacing-in] + 1) * ([Length] + 2) * [Faces] * [Horiz-Bar

CY Formulas



Dowels-Along-Lbs (([Length] * 12 / [Dowels-Spacing-In]) + 1) * [Dowel-Len-ft] * [Dowel-Bar-Size] 

Dowels-Ends-Lbs [Ends-Count] * [Ends-Bars-Per-End] * [Dowel-Len-ft] * [Dowel-Bar-Size] 

Dowels-Total-Lbs [Dowels-Along-Lbs] + [Dowels-Ends-Lbs] 

Rebar-Lbs--Vert ([Length] * 12 / [Vert-Spacing-in] + 1) * ([Wall-Height-ft] + 2) * [Faces] * [Vert-Bar-Siz

Rebar-Lbs-Horiz ([Wall-Height-ft] * 12 / [Horiz-Spacing-in] + 1) * ([Length] + 2) * [Faces] * [Horiz-Bar

Reinforcing Formulas
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Section 7 – Logistics (Pours)

Plan pours with ID’s, dates and progress tracking

This is a practical setup you can drop into your markups list to plan pours, track dates and measure % complete.

1) What we’re tracking (at the pour level)

Pour ID (e.g., P-101, SOG-A1, W2-East)

Element / Scope (Slab, Wall, Footing…)

Target Dates: Planned Pour, Cure/Strip, Ready-for-Next-Trade

Progress: Status, % Complete (manual or quantity-based)

Quantities: Planned CY/SF vs. Completed CY/SF

Notes / Constraints: Access, Pump, Crane, Crew, Readiness checks
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Columns to create (names as shown; use [brackets] 
in formulas)

Identification & dates

• Pour-ID — Text (or Choice if you want a dropdown)

• Element-Type — Choice (Slab, Wall, Footing, Column, Beam…)

• Planned-Pour-Date — Date

• Actual-Pour-Date — Date

• Cure-Complete-Date — Date (optional)

• Ready-For-Trade-Date — Date (optional)
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Columns to create (names as shown; use [brackets] 
in formulas)

Progess (status and % complete)

Pour-Status — Choice (Planned, Ready, In-Progress, Poured, Stripped, Complete)

Pct-Complete-Manual — Number (0–1 scale; e.g., 0.35 = 35%)

Pct-Complete-By-Qty — Formula

Pct-Complete — Formula (pick your driver)

Progress-Driver — Choice CY  Display: CY → Value: 1

    Display: SF → Value: 0

•: 0
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Percent Complete Formula

• Pct-Complete-By-Qty = [Progress-Driver] * ([Actual-CY] / [Planned-CY]) 

   + (1 - [Progress-Driver]) * ([Actual-SF] / [Planned-SF])

• Pct-Complete (Capped or Raw) — Formula

 = [Cap-At-100] * 1 + (1 - [Cap-At-100]) * [Pct-Complete-By-Qty]

•: 0
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Section 8 – Markups List Total & Exports

Summarize and share data across projects
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Markup Summary

A markup summary is a way to publish a report of your markups, from one or more PDF’s. Ths 
summary can be printed, or saved to a CSV or XML file that can be opened in Excel or appended 
to the end of a PDF. A summary is different from exporting markups because the data contained is 
is formatted to be read by other programs.

You can choose to create a single markup summary for multiple PDF’s included in a batch. Multiple 
summaries can be generated by Author, or any data type found in the Markups list.

Summaries have extensive filter and sort options and users can generate custom-designed PDF 
reports complete with company logo or export XML and CSV summaries, making highly useful 
data extremely portable. Export settings can be saved to make recreating customized markup 
reports quick and easy

•: 0
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Generating a Summary Report

1. From the Markups list toolbar click     Summary and select the desred output type 
(CSV,XML, PDF, or Print) or Go to Thumbnails >Markup Summary or Batch >    Summary .

2. The Markups Summary dialog box appears where you can select the file names and 
pages to include, the output export type (CSV, XML, PDF, or Print) 

3. By default, the active PDF’s are automatically included. To add additional files select Add 
menu which contain the following options

• Add Files

• Add Open Files

• Add Folder

• Add Folder (including subfolder)

• Add Current Set

To remove files from the list select it and click remove.

This batch of files can be saved for later use.
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Columns Tab

In the columns tab, you can select the markup data that should be included in the summary report 
from the lists.

• Columns that do not contain markup data will be missing, unless Show Empty Columns is 
enabled

• Items can be dragged and dropped to change the position of a particular item.

•: 0
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Filter and Sort Tab

In this tab, markup items can be filters to show a particular space or markups

• By default they are set to preexisting Markups list filters if no previous filters were applied this 
defaults to All. 

• Data can be filtered by markups not included in the report by selecting  Show All Columns.

• Select order of sort items and Ascending or Decending.

•: 0



© 2025 Bluebeam

Section 9 – Live Schedules (Legends)

Visualize quantities and logistics directly on your sheets
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What is a Legend?

• A Legend is a dynamic table in Bluebeam Revu that automatically lists selected markups in the 
drawing file.

• Provides a visual “key” for markups

• A legend is tied to specific markups that share properperties

• When you create a legend, it only includes the markups you selected (or those that match the 
same tool properties).

• You can add/remove entries, so a Legend becomes more of a filtered summary table, not a 
global “all markup lists.”

• If you want all markups shownm you’d need to ensure they’re either selected when creating the 
legend or configured to display in the legend properties

•: 0
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Why Use Legends

• They pull data directly from markups into the drawing file

• They act as a data summary inside the drawing.

• Enables you to create tables within the drawing, displaying the items and quantities from the 
markups

• They are dynamic, in that if the markups are changed, the legends update automatically with 
the updated data.

•: 0
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Creating Legends (Step 1)

• Open the Markups List (bottom panel)

• Select the markups you want to include.

• Right click → Legend → Create new legend

• Place the legend on your sheet

•: 0



© 2025 Bluebeam

Customizing the Legend (Step 2)

• Right Click in the Legend and Select Properties

• In the properties panel, select the Edit Columns button

• You can change the Title, the fonts, colors, fill colors, add or edit gridlines

• You can change page range or choose all pages

• Select the Edit Columns button to add or remove columns

•: 0
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Updating Legends (Step 3)

• Legends update automatically when the markups change.

• Add new markups, they appear in the legend.

• Delete/modify markups→ legend refreshes instantly

• Use across multiple pages or Sets.

•: 0
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Best Practices

• Standardize markup subjects/colors before creating legends.

• Place legends in consistent locations on sheets.

• Use in conjunction with custom tool sets.

• Keep legends clear and uncluttered.

•: 0
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Summary

• Legends = live keys for your drawing

• Save time, improve clarity, ensure consistency.

• Simple to create, powerful for collaboration.

•: 0
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Section 10 — Set-Wide Reporting

Generate summaries and dashboards across entire Sets
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What is Set-Wide Reporting?

• Collects markup data from all pages in a Set, not just one sheet.

• Generates summaries (quantities, statuses, responsibilities) across the whole project.

• Data can be displayed in Revu, or exported for external reporting.

•: 0
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Why Use Set-Wide Reporting?

• Consolidates all markup information into one place.

• Tracks quantities and progress across multiple drawings.

• Provides clear communication for project managers, estimators, and field teams.

• Supports QA/QC, punch, estimating, and submittal reviews.

•: 0
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The Process

Steps

• Open Markups List

• Group, filter and sort

• Customize Columns

• Click Summary > PDF Summary / CSV / XML.

• Options:

• PDF Summary → formatted report with hyperlinks back to drawings.

• CSV/Excel → for estimating, scheduling, or external analysis.

• Can be customized (include/exclude columns, groupings).
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Example Reports

• PDF Summary → with thumbnails and hyperlinks.

• Excel Output → sortable list of quantities/status.

• Use cases:

• Punchlist distribution.

• Quantity takeoffs.

• Submittal review tracking.
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Section 11 — AI / Scripting Teaser (Optional)

Extend Revu with automation, scripts, and future tools
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Why AI / Scripting

• Extend Bluebeam beyond manual workflows.

• Automate repetitive tasks (naming, stamping, TOC creation).

• Connect Revu with external data (Excel, specs, estimating tools).

• Provide smarter reporting and insights.
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AI in Action (Examples)

• Extracting data from drawings automatically.

• Generating summaries of markup activity.

• Predicting quantities or identifying missing markups.

• Conversational search: “Show me all CY_Slab markups over 500 SF.”
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Scripting Examples

• Batch Automation: Auto-generate legends or reports across Sets.

• File Management: Consistent naming, folder creation, PDF merging.

• Custom Tools: Python scripts that build logs, TOCs, or spare parts lists.

• Integration: Link with estimating databases or scheduling software.
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Demo Teasers

• AI-generated cover sheets.

• Automated O&M manual assembly.

• Exporting markup data into live dashboards.

• Watermarking and status automation.
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The Future

• Bluebeam → connected to AI assistants.

• Markups → instantly turned into structured project data.

• Reporting → always up-to-date, set-wide, and shareable.
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Closing Thought

• “If Legends and Set-Wide Reports save you hours today…
AI and scripting can save you days tomorrow.”
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